WebEx Meeting Center
Users Guide
Provided by Ameriprise & ConferencePlus

Simplify your business day
WebEx™ Users Guide

This guide provides tips and techniques that you can use to conduct effective meetings on the web. This guide is intended as a supplemental reference tool after attending a training session, and assumes that you are already familiar with the basics of your meeting service.

The guide will provide information on:
1. Preparing and launching your meeting
2. Managing participants
3. Presenting information and content
4. Description of features and functionality
5. Tips, tricks, and troubleshooting

WebEx Meeting Center: WebEx Meeting Center is a service that enables the easy sharing of information and expertise on the Web and allows business professionals to communicate more effectively and economically through interactive online meetings.

What can you do in a WebEx meeting?

+ Give any presentation to anyone, anywhere
+ Team Collaboration
+ Demonstrate software, live
+ Allow anyone in the meeting to view, annotate, and edit any document online
+ Share an application on your system or share the entire desktop
+ Distribute documents to the team immediately without using e-mail
+ Conduct on-line, “hands-on” training presentations
+ Use remote control to provide support on the web
+ Take meeting participants on a web tour
+ Add video to personalize your meeting
+ Review contracts or policies, make real time changes and SAVE the information on your computer immediately
# Table of Contents

**Preparing & Launching Your Meeting** ................................................................. 4  
  Per-Minute Model .................................................................................................. 4  
  Inviting Participants .............................................................................................. 6  

**Managing Participants** .................................................................................... 8  
  Granting Privileges ............................................................................................... 9  

**Presenting Information & Delivering Content** .................................................. 10  
  Meeting Window Overview ................................................................................. 10  
  Choosing an Option ............................................................................................. 11  
  Power Panels ....................................................................................................... 11  
  Share a Document or Presentation ...................................................................... 12  
  Sharing an Application ......................................................................................... 14  
  Sharing Multiple Applications ........................................................................... 18  
  Pausing/Stopping Application Sharing ............................................................... 19  
  Sharing Your Desktop .......................................................................................... 20  
  Sharing Video & Multimedia .............................................................................. 21  
  Sharing a Web Browser & Content .................................................................... 22  

**Tips & Tricks** .................................................................................................... 23  
  Controlling Full-Screen View ............................................................................ 23  
  Multimedia to Enhance Your Presentation ....................................................... 23  
  Transferring Files to Attendees .......................................................................... 24  
  Using Chat ......................................................................................................... 24  
  Using Annotation Tools ...................................................................................... 26  
  Multipoint Video ................................................................................................. 26  
  Improving Performance of Software Sharing .................................................. 28  
  Improving Performance of Document or Presentation Sharing ....................... 28  
  Synchronizing Displays ...................................................................................... 28  
  Displaying Animations and Slide Transitions .................................................. 29  
  Dial-up and High-Speed Connections ................................................................ 30  
  Clearing Your Web Browser’s Cache .................................................................. 30  

**Access & Support** ............................................................................................ 31  
  Obtaining a WebEx Account .............................................................................. 31  
  Obtaining Technical Support & Training ............................................................ 31
Preparing & Launching Your Meeting (Per-Minute Model)

You can launch your web meeting using links provided on your presenter invitation sent via email from conferencecenter@meetme.net. You may also launch your meeting online using MyAccount Dashboard.

**Presenter Invitation**

A link to your WebEx conference is included on your presenter invitation. Simply click on this link. Your browser will open and launch the ConferencePlus Meeting Center page. In Meeting Center, accept the terms and conditions and click on “Start”. Your WebEx conference will launch and you are ready to go!

**MyAccount Dashboard**

You may also access your online account management tool, MyAccount Dashboard, to launch your meeting.

- Go to [http://www.conferenceplus.com/ameriprise](http://www.conferenceplus.com/ameriprise)

- Login through the MyAccount box. Please refer to your Presenter Invitation or call the Ameriprise Reservations Center at 866-402-2673 to obtain your login credentials.

- Click on the “Launch Web Conference” icon associated with the desired conference and your WebEx conference will be launched.

Reservation Line: (866) 402-2673
How to Invite Participants

Using the Per-Minute Model

+ Forward your audience invitation email. A link to your WebEx conference is included on your audience invitation. Your participants simply click on this link. The participant’s browser will open and launch the ConferencePlus Meeting Center page. In Meeting Center, the participant will enter their information, accept the terms and conditions, and click on “Join”.

+ Another option is to copy and paste information from your audience invitation email into a Lotus Notes calendar invite.

+ To invite participants from within your open meeting, access the Participant menu and select Invite. Your participants receive an email with a link to join your web session already in progress.

Preparing for Your Meeting

The following tips can help you avoid complications and ensure that your meetings run smoothly:

+ Before you start a meeting, ensure that your computer and network are working properly to avoid any unexpected problems during the meeting.

+ Keep your internet browsing history cleared for optimal functionality.

+ Place all the files that you intend to share in a single folder, so you can quickly locate them during the meeting.

+ Start your meeting early, and practice sharing the documents and applications that you intend to share with attendees. That way, you can troubleshoot any problems before attendees join the meeting.

+ Once you start a meeting, write down the meeting number and host key. These numbers appear on the Info tab in the content viewer.
Establishing Meeting Guidelines

To help keep a large meeting running smoothly, you can provide attendees with a list of meeting guidelines to follow. For example, you can specify how and when attendees can ask questions, request annotation control, request remote control, and so on. To provide your guidelines to attendees, you can do either of the following:

- Specify your guidelines in the agenda of the meeting when sending out your invitations.
- Include your guidelines on the first slide in your presentation. Once attendees join a meeting, they can read the guidelines before the presentation starts.
- Open the meeting with a Whiteboard listing your guidelines
- Use the Chat feature to list your guidelines

Using Two Computers

To ensure that attendees can view shared presentations or applications properly; you (or the presenter) can monitor their view of the meeting by using two computers. Use one computer to present information, and use the other computer to view the meeting as an attendee.

Assistant Presenter

If you want to focus on speaking during a meeting, or want to view your presentation from an attendee's perspective, you can assign the presenter role to another attendee. This attendee can “drive” the presentation, by advancing slides and sharing applications, as you need them.

To promote an attendee to presenter, simply click on their name in the participant panel, and press the Make Presenter button, at the bottom of the participant panel.

To regain presenter rights yourself, simply click on your own name in the panel and press the Make Presenter button again.
Managing Participants

Participants to Join a Meeting

If attendees have trouble joining a meeting, they may be attempting to join a meeting that you have not yet started.

Because a meeting’s status can change at any time, an attendee can periodically click the Refresh button on the page to determine whether you have started the meeting.

Preventing Unauthorized Access to a Meeting in Progress

Once all required or invited attendees have joined a meeting, you can “lock” the meeting by restricting access to it. Restricting access to a meeting prevents anyone else from joining it. To lock a meeting, choose Restrict Access under the Meeting menu.

Providing Technical Support

Provide attendees with a phone number that they can call to receive support from your technical support personnel. Having this phone line available helps to ensure that all attendees can fully participate in a meeting.

To avoid having attendees interrupt a meeting when they need help, provide your support number on the first slide in the content viewer, in the header of each slide, or in the agenda. Your technical support team can be reached at 1-866-402-2673 (Option 2).

If using your audio conferencing number, attendees can simply press *0 on their touchtone phone for technical assistance. An operator will access their line, and they can specify that they need web help.

Handling Disruptive Participants

To prevent a disruptive attendee from taking control away from the presenter, take caution when granting privileges to attendees. If an attendee continues to disrupt a meeting, you can expel the attendee by selecting the attendee’s name on the Participants tab, and then choosing Expel on the Participant menu.

Once you expel an attendee, you can prevent the attendee from attempting to rejoin the meeting by choosing Restrict Access on the Meeting menu.
Granting Privileges to Participants

You can grant or remove privileges from attendees by accessing the Assign Privileges option. The privileges that you select determine whether all attendees can share documents, view shared documents independently, annotate shared documents, and so on.

To grant participant privileges during a meeting:

1. In the Meeting window, on the Participant menu, choose Assign Privileges. The Attendees Privileges dialog box appears.
2. Grant or remove a privileges, as follows:
   + To grant a specific privilege, select its check box.
   + To grant all privileges, select the Assign all privileges check box.
   + To remove a privilege, clear its check box.
   + To reset to the preset meeting privileges, click Reset to Meeting Defaults.
3. Click Assign.

Privileges

A host can grant the following privileges to one or more attendees:

- Chat - who an attendee can chat with and whether that chat can be private.
- Document - whether an attendee can draw on a document or save or print it.
- Viewing - what an attendee can view in the meeting: participant list, document, thumbnails, or pages.
- Meeting Task - whether an attendee can record the meeting, share documents, or control sharing.
Presenting Information & Delivering Content

A quick tour of the Meeting window

The Meeting window provides the online environment where meeting participants interact.

The Meeting window displays the content viewer on the left side, where the Presenter shares documents, whiteboards, and other items. The right side of the window contains panels, which you can display or hide as you need them.

For example, you may want to send a quick chat message to another participant. You can minimize or close the Chat panel after your exchange to reduce the clutter or provide more space for another panel. Panels are just a click away, so you can open a panel quickly. If you've closed or minimized a panel and it needs your attention, you receive an alert.

<table>
<thead>
<tr>
<th>Content Viewer</th>
<th>Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1" alt="Content Viewer" /></td>
<td>The tools on the content viewer toolbar allow you to share and perform actions on presentations, documents, and whiteboards.</td>
</tr>
</tbody>
</table>

| Annotation Toolbar | Annotation Toolbar - Select a drawing tool for directing attention onscreen, using pointers, a highlighter, or drawing a shape. |
| Sharing toolbar | Sharing toolbar - Use these tools to share applications, documents, your desktop or a white board. |
| Viewing toolbar | Viewing toolbar - Change to full-screen, rotate pages, zoom in or out using these tools. |
Choosing an Option

You can open a document, a whiteboard, or share your desktop or an application by clicking the sharing icons in the upper left corner:

<table>
<thead>
<tr>
<th>Sharing Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Share Document</td>
<td>![Document Icon]</td>
<td>Share a document or presentation that resides on your computer. Participants view the shared document or presentation in their content viewers.</td>
</tr>
<tr>
<td>Share Application</td>
<td>![Application Icon]</td>
<td>Share any application on your computer with meeting attendees. Attendees can view the shared application in a sharing window on attendees' screens.</td>
</tr>
<tr>
<td>Share Desktop</td>
<td>![Desktop Icon]</td>
<td>Share your computer desktop* with meeting attendees, including any applications, windows, and file directories that are currently open. Attendees can view the shared desktop in a sharing window on attendees' screens.</td>
</tr>
<tr>
<td>Share Whiteboard</td>
<td>![Whiteboard Icon]</td>
<td>Share a whiteboard on which you can draw and write. Attendees can view a shared whiteboard in their content viewers.</td>
</tr>
</tbody>
</table>

Power Panels

<table>
<thead>
<tr>
<th>Sharing Tool</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Participants</td>
<td>Identifies who is in the meeting and who is the presenter.</td>
</tr>
<tr>
<td>Chat</td>
<td>Type your chat comments here.</td>
</tr>
<tr>
<td>Video Panel</td>
<td>If enabled, click to see live video from the presenter’s and participants web cameras.</td>
</tr>
<tr>
<td>Record</td>
<td>Record your session.</td>
</tr>
<tr>
<td>PowerPoint Notes</td>
<td>Refer to your PowerPoint slide notes.</td>
</tr>
<tr>
<td>Polling</td>
<td>Click to setup questions and collect answers.</td>
</tr>
</tbody>
</table>
Sharing a Document or Presentation in Content Viewer

The Presentation or Document command on the Share menu displays a presentation or document in the content viewer. If you used Microsoft PowerPoint to create your slides, the content viewer also displays any animations and transitions on the slides. This sharing option provides a set of annotation tools that both you and attendees with annotation privileges can use; viewing options, such as thumbnails and full-screen view; and simultaneous use of the entire Meeting window, including the participant list and chat.

To share a document or presentation:

1. In the Meeting window, do either of the following:
   - On the toolbar, click on the Share Presentation or Document button.
   - Or
   - On the main toolbar, choose Share then Presentation or Document.

2. The Share Presentation or Document dialog box appears.
3. Select the document or presentation that you want to share.
4. Click Open.
   Meeting Manager first opens the document or presentation, and then displays it in your content viewer. Participants can then view the document or presentation in their content viewers.
   If you share a Microsoft PowerPoint presentation, Meeting Manager automatically displays the Presentations tab in the Meeting Options dialog box, on which you can choose whether or not to display animations and slide transitions.
5. To ensure that all participants can view the entire page or slide in their content viewer, click the Synchronize button located on the bottom toolbar.
6. To display a different page or slide, do one of the following:
• To display the next page or slide, click the Next button.

• To display the previous page or slide, click the Previous button.

If you are sharing Microsoft PowerPoint slides that include animations, do the following to display different slides and their animations:

To display the next slide or animation, press the Up Arrow, Right Arrow, or Spacebar on your computer's keyboard.

To display the previous slide or animation, press the Down Arrow or Left Arrow on your computer's keyboard.

Notes

+ If you open another document or presentation, Meeting Manager adds another tab to top of the content viewer. You can display different documents or presentations by clicking the tabs.

+ If you select an HTML document to share, a message appears. Click OK to open the document in a Web browser window. Then print the document using the ActiveTouch Document Manager, which appears in your list of printers. The document then appears in the content viewer.

+ If Meeting Manager cannot determine the application with which a document or presentation was created, you must manually open the document outside of the Meeting window. Then print the document using the ActiveTouch Document Loader, which appears in your computer's list of printers. The document then appears in the content viewer.
Sharing an Application

Instead of displaying a presentation or document in the content viewer, you can open the presentation or document in the application with which it was created, and then share the application. Sharing a presentation or document as an “application” lets you or an attendee edit the slides or pages during the meeting. However, while you are sharing an application, the Meeting window is not available, so you will need to use the toolbar located in the lower right corner of your screen.

To share an application:

1. In the Meeting window, on the main toolbar, choose Share then Application.
2. The Share Application dialog box appears, showing a list of all applications currently running on your computer.
3. To view additional applications, click on the New Applications button.
4. In the list, select the application that you want to share.
5. Click Share.

The Meeting window minimizes on your computer. If the application is not already running, it starts automatically.

Your application appears in a sharing window on participants' screens.
Notes

+ While sharing an application, you can return to the Meeting window, causing all participants to return to their Meeting windows automatically.

+ To save time during a meeting, begin sharing one or more applications before the meeting's starting time, and then minimize their windows. At the appropriate time during the meeting, you can quickly begin sharing an application by restoring its window, without waiting for the application to start.

+ If you cover a shared application or Web browser with another window on your computer's desktop, attendees cannot view the area of the application or browser that the other window covers. Instead, a crosshatched pattern appears in the covered area on attendees' screens. To help avoid this problem, ensure that you minimize all applications that are running on your computer, and then restore the window for only the application or browser that you want to share.
Accessing Panels in Full-Screen View

While you are viewing a document, or viewing or remotely controlling a shared application, desktop, or Web browser, the Meeting window you can switch between a standard window and full-screen view. In a sharing window, you access panels from the Meeting Controls Panel.

Tip: To clear space on your desktop, you can minimize or drag the Meeting Controls Panel to the top, left, or right to dock it on the edge of the window. To undock the icon tray and float it again, simply drag it away from the edge of the window.

**Control**

1. Displays icons for working with attendees
2. Displays a maximum of 4 panel icons. You can open any remaining panels from the Select menu
3. Stops sharing and returns to the Meeting window
4. Provides access to meeting controls and panels that are not displayed on the Meeting Controls Panel
5. Displays the Participants panel
6. Displays the Chat panel
7. Displays the Annotation Tools panel
8. Displays the Polling panel
9. Displays the Notes panel
10. Displays the Video panel
11. Displays the Recorder panel
Sharing Multiple Applications

Host or Presenter only

If you are already sharing an application, you can share additional applications simultaneously. Each application that you share appears in the same sharing window on attendees' screens.

To share an additional application:

Select the application you want to share:

+ **If application is running:** Click the Share button in the upper right corner.

  ![Share button](image)

  Each application you have open on your desktop has these buttons in the upper right corner.

  **Tip:** When you open any application that you have minimized, it opens with the sharing buttons in the upper-right corner.

+ **If that application is not currently running:** Click the Select Content to Share button in the Meeting Controls Panel. You can also find it using File Explorer or other tool you use to locate applications on your computer. When you open it, it appears with the Share button.

Your application appears in a sharing window on attendees' screens.

Meeting Center tracks the number of applications you are currently sharing:

![Applications sharing](image)

The button to the right of Pause is the Select Content to Share button.

**Tip:** Alternatively, you can share multiple applications by sharing your computer's desktop.
Stopping Application Sharing for all participants

*Host or Presenter only*

You can stop sharing an application at any time. Once you stop sharing an application, attendees can no longer view it.

If you are sharing multiple applications simultaneously, you can stop sharing either a specific application or all applications at once.

**To stop sharing a specific application when sharing multiple applications:**
On the title bar of the application that you no longer want to share, click the *Stop* button.

![Stop button](image)

**To stop all application sharing:**
In the Meeting Controls box, click the *STOP* button.

![Meeting Controls](image)

You can also pause sharing: Click the *Pause* button (located next to the *Stop* button).

---

Pausing and resuming Application Sharing for all participants

*Host or Presenter only*

While sharing software, you can temporarily pause sharing to freeze attendees' views of shared *applications*, *desktop* (if available), or *Web browser*.

If you want to return attendees to the Meeting window while sharing software, pausing shared software conserves resources on your computer and bandwidth for your Internet connection. This option is also useful if you do not want attendees to see certain actions that you take with shared software.

You can resume sharing to restore attendees' views of shared software at any time.

**To pause software sharing:**
Click the *Pause* button, located to the right of the *Stop* button.

![Pause button](image)

The word "Paused" now appears in the panel.

**To resume software sharing:**
Click the *Pause* button again.
Sharing Your Desktop

The Share Desktop command on the Share menu will display your computer’s desktop. The attendees will see all of your open applications and windows.

To share your desktop:

+ In the Meeting window, on the main toolbar, choose Share then Desktop.

+ The Share Desktop dialog box appears.

+ Optional - To allow a participant to control your desktop remotely, click the Sharing button. In Allow to control remotely, select the name of the participant.

+ Click OK.

+ The Meeting window minimizes on your computer. And your computer’s entire desktop appears in a full-screen view on participants' screens.
Sharing Video & Multimedia

The Presentation or Document command on the Share menu will also stream multimedia content, such as flash movies, or audio/video files via Windows Media Player in the content viewer.

To share a multimedia clip:
+ In the Meeting window, do either of the following:
  - On the toolbar, click on the Share Presentation or Document button.
  - Or
  - On the main toolbar, choose Share then Presentation or Document.

+ The Share Presentation or Document dialog box appears.
+ Select the document or presentation that you want to share.
+ Click Open.
Meeting Manager first opens the document or presentation, and then displays it in your content viewer. Participants will not begin viewing the clip until the presenter has initiated playback.
+ As the media loads, you will see the following below the content viewer:

  This area indicates the status of the media download.

  Once all participants have the content loaded, click the ‘Play’ button.
Sharing a Web Browser

Web browser sharing allows you to take attendees on a “Web tour.” Attendees can view each Web page that you access, either on the Internet or on your organization’s private intranet. You can optionally allow attendees to control your Web browser.

**To share a web browser:**

+ In the Meeting window, on the main toolbar, choose *Share* then *Web Browser*.

+ The Meeting window minimizes on your computer, and your default web browser opens.

+ Your web browser appears in a sharing window on participants' screens.

+ Participants will view all your actions as you navigate with your browser.

Differences between sharing web content and sharing a web browser

Meeting Center provides two options for sharing Web-based information. You can share Web content or share a Web browser with meeting participants. Choose the feature that better suits your needs.

<table>
<thead>
<tr>
<th>Sharing option</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web browser sharing</td>
<td>+ Lets you guide participants to various Web pages and sites on the Web.</td>
<td>+ Does not display media effects or transmit sounds on Web pages.</td>
</tr>
<tr>
<td></td>
<td>+ Lets you grant attendees control of your Web browser.</td>
<td>+ Does not let participants interact with Web pages independently.</td>
</tr>
<tr>
<td></td>
<td>+ Lets you and other participants annotate Web pages.</td>
<td></td>
</tr>
<tr>
<td>Web content sharing</td>
<td>+ Displays Web pages, and lets participants experience media effects on Web pages, including video and sound.</td>
<td>+ Does not let you guide participants to other Web pages.</td>
</tr>
<tr>
<td></td>
<td>+ Lets participants interact with Web pages independently in their content viewers.</td>
<td></td>
</tr>
</tbody>
</table>
Sharing Web Content

To share a Web page on the Internet that includes multimedia effects, such as sound and animation, you can use Web content sharing. This option lets you specify a URL for a Web page, video, audio file, or flash file, and display the content in the content viewer on each attendee’s screen. Attendees can hear sounds and interact with other multimedia effects independently in their content viewers. This option also lets you share a single Web page more quickly than you can using the Web browser sharing option; however, it does not allow you to guide attendees to other Web pages.

To share web content:

+ In the Meeting window, on the main toolbar, choose Share then Web Content.

+ A pop-up box appears. Enter the website address and click OK

+ The website loads into the content viewer.
Tips, Tricks, & Troubleshooting

As you host more and more web meetings, you’ll likely want to learn about tips and tricks to enhance your meeting experience. This section provides information on the more advanced features of the WebEx Meeting Center.

Controlling full-screen view of shared software

*Host or Presenter only*

You can switch attendees’ views of a shared application or Web browser between a standard window and a full-screen view.

A full-screen view of shared software fits attendees’ entire screens and does not include a title bar or scroll bars.

Attendees can override your setting to control full-screen view or to zoom in or out on the shared software on their computers.

To display shared software in a full-screen view:

On the Meeting Controls Panel, click the down arrow (the last button on the panel) and then choose **View**. Then choose **Full screen for Participants**.

Using UCF Multimedia to Enhance Your Presentation

You can make an online meeting more engaging by sharing any of the following types of media files in the content viewer:

- Audio files
- Flash movie and interactive Flash files
- Web pages

To share a media file, you must use a Universal Communications Format (UCF) media object. A media object links to the media file and provides a window in which the file appears. An object also contains options and controls for displaying or manipulating the file.
You can share media files in either of two ways:

+ In a Microsoft PowerPoint presentation—Using the WebEx Universal Communications Toolkit, a plug-in for Microsoft PowerPoint, you can insert UCF objects into your slides. You can then share the presentation during a meeting.

+ As a standalone file—you can share a media file directly in the content viewer. Meeting Manager creates a UCF object for the file automatically, which appears in the content viewer.

**Transferring Files to Attendees**

During a meeting, you can transfer any types of files to attendees, by choosing Transfer on the File menu. The following are some examples for using this option:

+ Provide attendees with a copy of your presentation or any other documents that you share during the meeting.

+ If you are training attendees on how to install and use an application, provide attendees with the application's installation program.

+ If you take a poll during a meeting, provide attendees with a copy of the poll results file that you saved. Attendees can open a poll results file using any text editor.

**Using Chat**

Chat is useful during a meeting if you want to:

+ send brief information to all participants or a specific group of participants
+ send a private message to another participant
+ ask a question but do not want to use the Q & A option, which provides a formal procedure for asking and answering questions

All chat messages that you send or receive appear on the Chat panel in the meeting window.

The Chat function allows you to perform these tasks:

+ Send chat messages
+ Print chat messages
+ Save chat messages
Sending chat messages
During a meeting, the presenter can specify chat privileges for participants. These privileges determine to whom participants can send chat messages.

To send a chat message:
1. Open the Chat panel.
2. In the **Send to:** drop-down list, select the intended recipient.
3. Enter your message in the chat text box.
4. Click **Send**.

Printing chat messages
You can print all the chat messages that appear on the Chat panel.

To print chat messages:
1. In the Meeting window, on the **File** menu, choose **Print > Chat**.
   A print dialog box appears.
2. Optional. Specify printer options.
3. Print.

Meeting Manager saves the chat messages in a .txt file at the location you selected.
Using Annotation Tools

If, while sharing software, you are the presenter or the presenter allows you to annotate, you can use the Annotation Tools panel that appears to make annotations. The Annotation Tools panel provides a variety of tools for annotating a shared desktop or application.

<table>
<thead>
<tr>
<th>Annotation Tool</th>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pointer</td>
<td><img src="image" alt="Pointer Icon" /></td>
<td>Lets you point out text and graphics on shared content. The pointer displays an arrow with your name and annotation color. To display the laser pointer, which lets you point out text and graphics on shared content using a red &quot;laser beam,&quot; click the downward-pointing arrow. Clicking this button again turns off the pointer tool.</td>
</tr>
<tr>
<td>Text</td>
<td><img src="image" alt="Text Icon" /></td>
<td>Lets you type text on shared content. Attendees can view the text once you finish typing it and click your mouse in the content viewer, outside the text box. To change the font, on the Edit menu, choose Font. Clicking this button again turns off the text tool.</td>
</tr>
<tr>
<td>Line</td>
<td><img src="image" alt="Line Icon" /></td>
<td>Lets you draw lines and arrows on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td>Rectangle</td>
<td><img src="image" alt="Rectangle Icon" /></td>
<td>Lets you draw shapes, such as rectangles and ellipses on shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Rectangle tool.</td>
</tr>
<tr>
<td>Highlighter</td>
<td><img src="image" alt="Highlighter Icon" /></td>
<td>Lets you highlight text and other elements in shared content. For more options, click the downward-pointing arrow. Clicking this button again closes the Highlighter tool.</td>
</tr>
<tr>
<td>Annotation Color</td>
<td><img src="image" alt="Annotation Color Icon" /></td>
<td>Displays the Annotation Color palette, on which you can select a color to annotate shared content. Clicking this button again closes the Annotation Color palette.</td>
</tr>
<tr>
<td>Eraser</td>
<td><img src="image" alt="Eraser Icon" /></td>
<td>Erases text and annotations or clears pointers on shared content. To erase a single annotation, click it in the viewer. For more options, click the downward-pointing arrow. Clicking this button again turns off the eraser tool.</td>
</tr>
</tbody>
</table>


Letting an attendee Annotate shared software

*Host or Presenter only*

You can let one or more meeting attendees annotate a shared desktop, application or Web browser.

You can let several attendees annotate shared software at the same time.

**To let an attendee annotate shared software:**

1. On the Meeting Controls Panel, click the **Start Annotating** icon.

   ![Start Annotating button](image)

   The Start Annotating button is the fourth gray button from the left.

2. The tools panel appears.

3. Click the down arrow on the **Allow to Annotate** button.

4. On the menu that appears, choose which participants can annotate the shared software: You can choose "All" or select someone from the list.

**Multipoint Video - Sending and Viewing Video**

If a video camera is attached to your computer, you can broadcast live video to meeting participants. Live video lets other participants see you, an object under discussion, and so on. All participants can view your live video, without the need for video equipment installed on their computers.

**Setting up video**

To set up video, you must connect a video camera—also called a webcam—to your computer. After you start or join a meeting, Meeting Manager automatically detects your video camera.

Generally, Meeting Manager is compatible with any video camera that connects to your computer’s USB or parallel port. The quality of the video image can vary, depending on the quality of the video camera that you use.
**Important:** After you install your webcam software, check that your webcam is operating properly. Then close the software program you installed with your webcam before starting or joining a meeting. WebEx does not need this software program running during a meeting and leaving this program running could interfere with the video features in your meeting.

**Using multipoint video**

With multipoint video, you can allow up to six participants with video cameras attached to their computers to send live video during a meeting.

**To select participants to send live video (Windows):**

1. Make sure the video option for your meeting set to multipoint.
2. On the Meeting menu, choose **Options**, then select **Multipoint**.
3. In the Meeting window, display the **Video** panel.
4. If the panel is closed or minimized, click the **Video** button in the Meeting window or the Video icon on the icon tray in sharing mode.
5. Click the icon at the top of the panel for the number of video displays you want to display.

You can display video from up to six meeting participants (with webcams) at one time. Click to select the number of video displays you want to see: one, two, four, or six.
Improving Performance of Software Sharing

To improve the performance of software sharing, do the following:

+ Close all applications that you do not need to use or share on your computer. Closing applications conserves processor usage and memory on your computer, thus helping to ensure that Meeting Manager can send images of shared software quickly during a meeting.

+ To ensure that the maximum amount of bandwidth is available for software sharing, close any applications on your computer that use bandwidth, such as instant messaging or chat programs, and programs that receive streaming audio or video from the Web.

+ Ensure that the Meeting Manager display mode is set optimally for the application that you are sharing. You can choose one of two display modes: one for normal applications and another for graphics-intensive applications. To set the display mode, on the Meeting menu, choose Options.

Improving Performance of Document or Presentation Sharing

You can improve the speed at which shared pages or slides appear to attendees by doing any of the following:

+ Limit the number of animations and slide transitions that you add to Microsoft PowerPoint slides.

+ Minimize the number of screen captures that you add to slides, especially if they are bitmap graphics. Such graphics do not compress well.

+ Do not include more than 20 to 30 slides in one presentation file. If you want to share more slides, create a separate presentation file for each set of 20 to 30 slides.

+ Keep the size of the presentation file to a maximum of 5 MB.

Synchronizing Displays

When you share a document or presentation in the content viewer, some participants may not be able to view the entire page or slide that you are sharing because their viewers are set to different magnifications. To resolve this problem, simply click the Synchronize button on the toolbar. All participants’ content views then display the page or slide at the same magnification that you set in your viewer.
Displaying Animations and Slide Transitions

When sharing a Microsoft PowerPoint slide presentation in the content viewer, you can display animations on the slides and slide transitions.

Once you begin sharing a presentation, you can perform slide transitions or animations, as follows:

+ Click anywhere in the content viewer to set the input focus. A blue border around the shared slide indicates that the viewer has input focus.
+ Do either of the following:
  o To perform the next slide transition or animation, click the Next button on the toolbar.
  o To perform the previous slide transition or animation, click the Previous button on the toolbar.

You can also use the keys on your keyboard to perform slide transitions or animations, or to navigate your slides:

<table>
<thead>
<tr>
<th>To…</th>
<th>Press…</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display the next slide or perform the next animation or slide transition</td>
<td>Space Bar, Page Down, Right Arrow or Down Arrow</td>
</tr>
<tr>
<td>Display the previous slide or perform the previous animation or slide transition</td>
<td>Page Up, Left Arrow or Up Arrow</td>
</tr>
<tr>
<td>Display the first slide</td>
<td>Home</td>
</tr>
<tr>
<td>Display the last slide</td>
<td>End</td>
</tr>
</tbody>
</table>

**Note:** If you are unable to display animations or slide transitions, ensure that you import the presentation using the Universal Communications Format (UCF) import mode: On the Meeting menu, choose Options, and then click the Import Mode tab.
**Dial-up and High-Speed Connections**

Attendees who use dial-up connections to the Internet can avoid unnecessary delays in screen updates during a meeting by connecting to their local ISPs, rather than to their corporate servers. Connecting to a corporate server can cause delays in receiving meeting data because the data must traverse a longer path, and thus is more likely to traverse congested lines.

If you use a dial-up connection, poor phone lines and equipment in your area may affect your meeting experience. If you suspect that such a problem exists in your area, contact your phone service provider.

Even if you use a high-speed connection—such as ISDN, DSL, Cable, T1, or T3 you may experience bandwidth limitations or data loss. These problems may originate with your ISP or a major hosting facility in your area. For example, some ISPs use proxy servers to handle inbound and outbound network traffic. These servers can reduce your connection speed and thus affect the performance of your meeting service.

**Clearing Your Web Browser’s Cache**

Clearing your Web browser’s cache can improve your browser’s performance, and thereby, your meeting experience. To clear you browser’s cache, follow these steps:

**Internet Explorer 8.x**
- Click on Safety, select delete browsing history
- Check mark all boxes and click Delete

**Internet Explorer 7.x**
- On the Tools menu, choose Internet Options
- Under Browsing History, click Delete
- Click Delete Files

**Internet Explorer 5.x and 6.x**
- On the Tools menu, choose Internet Options
- Under Temporary Internet files, click Delete Files

**Netscape Navigator**
- On the Edit menu, choose Preferences
- Expand Advanced
- Select Cache
- Click Clear Disk Cache
Access & Support

The following section provides information on obtaining a WebEx account and receiving support.

**Obtaining a WebEx Account**

To provide a quality experience for all users of the service, each person should complete a request form for a WebEx account. To request an account, please click on this link or copy/paste the link into your web browser:

http://info.conferenceplus.com/g/?PEGOOZR484

If you have any questions, or would like more information, please contact one of the ConferencePlus team members.

**Obtaining Technical Assistance**

To receive web technical support for your meeting service:

- Call 1-888-402-2673, Option 2, Option 2

If you are connected to a ConferencePlus audio conference, you may press *0 at anytime to receive technical assistance.

**Obtaining Additional Training**

To receive additional complimentary training, or if you require any additional assistance, please contact your support team:

Joan Hooson  
Conferencing Consultant  
847 413 3464  
jhooson@conferenceplus.com

Chuck Lopez  
National Account Manager  
847 413 3327  
clopez@conferenceplus.com